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What is Visio? 

 

Microsoft Visio is a diagramming program  

designed to assist users  

in the creation and illustration of  

idea’s, processes, and systems. 
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What does Visio do? 
 

Through the use of Visio templates the user can create: 

� Calendars 

� Timelines 

� Organizational Charts 

� Networking Diagrams 

� Building plans 

� Pert Charts 

� Gantt Chart 

� Brainstorming diagrams 

� Block Diagrams 

� Charts & Graphs 

� Electrical & Mechanical Engineering Diagrams 

� Flowcharts 

� Maps 

� Networking Diagrams 

� Data Base Diagrams 

� Business Process Diagrams 
 

   The user also has the option to create a new blank Visio Drawing 
    and use the shapes and symbols from the above templates to create 
     their own diagram. 
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Workshop Syllabus  
 

1. Introduction 

a. Description 

b. Applications 

2, Visio Elements 

a. Interface Elements 

b. Nature of Shapes 

c. How to Use Text 

D. Borders and Titles 

3. Creating Diagrams 

a. Creating Flow Charts 

b. Creating Organizational Charts 

4. Enhancing Appearance 

5. Other Sources of Information 
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 Shapes 
 

Visio shapes are pre-drawn picture elements that can be dragged and dropped into a diagram to  
visually communicate information and processes. 
 
 

1-D and 2-D Shapes 
• There are two types of shapes in Visio: one-dimensional shapes (1-D shapes) and two-

dimensional shapes (2-D shapes).  

1-D shapes connect things 

2-D Shapes represent things 

 

• 1-D Shapes ~  

• have only 2 handles when selected 

• have a beginning point  and an ending  point   

• typically are lines.  

• are used to connect 2-D shapes 
 

 

 

• 2-D Shapes ~ 

• have 8 handles  

• have 2 dimensions: length and width, which are adjustable 

• Are typically used to represent things 
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 Shape Handles 
Selection Handles 

  Appear on a shape as red or green boxes.  
  The user can resize shapes or connect shapes, using these handles.  

 
Connection points 
This appears as a blue x on a Visio shape.  
At these points Visio allows the user to glue connectors or lines.  

 
Rotation Handles 
Appears as a green or red circle on Visio shapes.   
This handle is used to rotate shapes. 

 
Control Handles 
Appears as a yellow diamond on some Visio shapes.  
This handle is used to control a shapes appearance and  
Can sometimes make the shape appear 3 dimensional. 

 
Eccentricity Handles 
This appears as a green circle with a plus symbol inside.   
This handle is used to extend 1-D shapes. 

Control Handle 

Eccentricity Handle 

Connection Point 

Eccentricity Handle 

Control Handle controls 
the gray area which 
makes the arrow appear 3
-dimensional. 
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More About Shapes 
• About Stencils and Shapes 

1. Shapes window: This window contains stencils.    

2. Stencils: Stencils contain shapes.    

3. Shapes: Shapes are Visio’s building blocks and are contained in stencils.  
 
 
 
 
 
 
 
 
 
 
 
 

 

 

The illustration shows the Organization Chart stencil and its shapes. Notice the two other stencils: Bor-
ders and Titles and Backgrounds. To see the shapes in either of those stencils, you'd just click on the 
name of the stencil. 
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Getting shapes 
• with templates 

• when first opening Visio, click on “Getting Started,” samples, or stencil categories. 

• then the stencil that most closely meets your criteria 

• by searching 
• Type one or two words in the Search for Shapes box.  

•  Visio creates a temporary stencil to hold the shapes it finds  

• by browsing the stencils 
• Start with: File>Shapes 

• by drawing your own 

• inserting pictures 
 
 
 
 
 

 
 
 
 
 
 
 

Templates 

Searching 
Browsing Stencils 
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 Types of Connectors 
 
 

C onnectors in Visio are used to define relationships between two shapes.  You can connect shapes in Visio through 
the use of straight line connectors, line-curve connector or dynamic connectors. 

 
Straight Line Connectors 

Connects two shapes together with a straight line.  
This connector will shorten, lengthen and change its angle if one of the connected 
shapes is moved. 

 
 Dynamic Connectors 

This type of connection tool allows the user to move objects in the Visio Drawing 
window and still maintain a clear connection between shapes. 
 
The dynamic connector automatically bends, stretches and moves around other 
shapes in the drawing window. 

 
 Line Curve Connectors 

Line-Curve connector: Connects two shapes together with a curved line.  
This connector will shorten and lengthen if one of the connected shapes is moved. 
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Two Ways of Making Connections 
 
There are two ways to connect shapes using Visio 2007: 
 
• Point-to-point connection: in this form of shape connection the connector will stay on the point where 

the user originally place the connection when a connected shape is moved. 
 

1. Place two shapes in your drawing window. 

2.  Note: Visio is a drag and drop program, so to place a shape on the drawing 
choose the shape and drag it to the drawing window and release the mouse 

3. Click on the Dynamic Connection tool 

4. Drag the connection tool to the connection point on the first shape, then to 
the connection point on the second shape. 

5. The connection end will turn red when the shape is connected 

6. Your two shapes are now connected point-to-point. 
 
 

• Shape-to-shape connection: in this form of shape connection the connector will move around the 
shape maintaining a connection when a shape is moved. 

 

1. Place two shapes in your drawing window. 

2. Click on the Dynamic Connection tool 

3. Drag the connection tool so it is positioned over the center of the first shape 
until a red box appears around the shape. 

4. Hold down the left mouse button and drag the connection symbol to the center 
of the second shape and wait till a red box appears around the second shape  

5. Release the mouse. 

6. Your two shapes are now connected shape-to-shape. 
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Auto Connecting Shapes 
While dragging shapes onto the page . . . 

1. Drag a shape from a stencil onto the drawing page and position it near another shape. 

          

2. While still holding down the mouse button, move the pointer over one of the blue triangles. The tri
 angle turns dark blue. 

           

3. Release the mouse button. The shape is placed on the drawing page, and a connector is added 
and glued to both shapes 

                                            

 
   Tip:    If you don't like dragging shapes, you can achieve the same result by first selecting a shape in  
   the stencil, resting the pointer over a shape in your drawing, and then clicking one of the blue  
   triangles that appear near that shape. 
 



Microsoft Visio Workbook      Page  14 

 

 
Using AutoConnect with shapes already on the page 

Rest the pointer over the shape that you want to connect from. 

                               

 

Position the pointer over the blue triangle that is closest to the shape that 
you want to connect to. 

 
 

 
 

The triangle turns dark blue, and a red box appears around the shape that 
you want to connect to.  

  Note   If a red box does not appear around the shape that you 
  want to connect to, the shape may be too far away. Move 
  the shape closer and try again, or use the Connector tool. 
  Click the blue triangle. A connector is added and glued to 
  both shapes. 
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Enable or Disable AutoConnect 
   
 You can enable or disable the AutoConnect feature in all Visio drawings, or in only the cur-
 rent drawing. 

Enable or disable AutoConnect in all Visio drawings 

1. On the Tools menu, click Options. 

2. Click the General tab. 

3. Under Drawing window options, select the Enable AutoConnect check box. 

 

Enable or disable AutoConnect in the current drawing 

1. On the Standard toolbar, click the AutoConnect tool. 

2. Note: If clicking the AutoConnect tool does not enable AutoConnect, make 
sure the Enable AutoConnect check box is selected in the Options dialog 
box. 

 
 

Rulers and gridlines   
• When you position shapes on the page — or when you first add shapes to 

the page — use the grid lines to keep them straight. And keep an eye on 
the grid to make sure that your shapes are evenly spaced. 

• The rulers are also invaluable. Use them to see the exact distance be-
tween shapes or to know just how big a certain shape is. These numbers 
are especially important if you are creating a detailed office layout or building plan that will control physi-
cal measurements. 

• By default, shapes snap to the grid lines and the measurement lines on the rulers. This behavior makes it 
much easier to position shapes. You don't have to do fussy hand work to get a shape in the right place. It 
puts itself where you want it, and stays there unless you move it. 
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Guides 

• Even more visible than the grid lines are the guides: vertical or horizontal lines that you can place on a 
page.  

• You drag them from a ruler, and by default they appear blue, 
as in the illustration.  

• Guides help you organize your diagrams according to their con-
tent.  

• If you know that your flowchart shows three processes, for ex-
ample, you can evenly space three vertical guides on the page.  

• Then you can position the shapes running down each one. (In 
case you're wondering, guides don't show up on printed dia-
grams. They're your secret.) 

• Guides are also handy to mark off the margins of the page as well. 

 
 

Size & Position window 
• The location of a shape is stated in terms of X and Y coordinates.  

• The X coordinate is the position on the horizontal ruler at the top of 
the page.  

• The Y coordinate is the position on the vertical ruler at the left of 

the page. The point where these meet is the shape's pin .  

• For most shapes, the pin is the center of the shape. 

• To move the shape, type in new numbers for the coordinates.  
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 Moving Shapes 
Aligning Shapes 
• Select the shapes you want to align 
• Select Shapes menu > Align > alignment option 
• Your shapes are aligned 

 
Distributing Shapes 
• Select the shapes you want to distribute 
• Select Shapes menu > Distribute > distribute option 
• Your shapes are evenly distributed 

 
Rotating Shapes & Flipping shapes 
• Select the shape you want to rotate or flip 
• In the Shapes menu, select Rotate or Flip 
• Select the relevant Rotate or Flip command 
• Your shape is rotated or flipped 

 
Stacking Shapes 
• By default, Visio puts shapes in a stacking order as you add them to the page. 
• The rule to remember, for how Visio establishes the stacking 

order, is "The last one in wins." 
• What that means is, the last shape you place on the page is 

highest in the stacking order.  
• In this example, the computer is on the top of the other shapes 

because it was the last one added to the page. 
• To change a shape's position in the stacking order, select the shape, and then point to Order on the 

Shape menu. You'll see four options. Bring to Front or Send to Back move a shape all the way in the 
stacking order. 
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   Grouping Shapes 
 

• The first step in grouping shapes is to select the shapes. You can do 
this by holding down the SHIFT key while you click them, or by drag-
ging a selection net around them. 

• When you've got the shapes selected, on the Shape menu you click 
Grouping and then click Group. That's it: the shapes are now grouped. 

• You can do anything to a group of shapes that you can do to a shape: 
resize it, rotate it, align it with others, and so on. Visio treats a group 
as one big 2-D shape. 

• Tip    The shortcut key for grouping is CTRL+SHIFT+G. (Think "G for Group.") 
 

Text 
Text in Shapes 
• Click and type to add text, and  
• Double-click a shape to edit text 

 
Text-Only Shape 

• To define the area for the text, you first use the Text Tool to click and drag a bounding box. 
• Visio will zoom in so that you can see what you are typing. 
• The bounding box establishes the area that the text will occupy.  
• It can be wide or skinny, long or short. It's up to you.  
• The only thing it can't be is round or curvy. It can only be rectangular. 

 
Text in Grouped Shapes 
• Click the group of shapes with the Pointer Tool.    
• Click again to select one of the shapes in the group.    
• Click the Text Tool button.  
• Add or change the text as you see fit 
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Basic Flowcharts 
 

Flowcharts are diagrams that show the steps 
in a process. Basic flowcharts are easy to 
create and, because the shapes are simple 
and visual, they are easy to understand. 
 
The Basic Flowchart template in Microsoft 
Office Visio 2007 comes with shapes that you 
can use to show many kinds of processes, 
and it is especially useful for showing basic 
business processes like the proposal develop-
ment process shown at the right. 
 
Through the use of this tool the user can cre-
ate flowcharts, top-down diagrams, informa-
tion tracking diagrams, process planning dia-
grams, and structure prediction diagrams. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Team member 
suggests project

Team discusses 
idea in meating

Participants 
decide if it’s a 

good idea

Team rejects idea
Team member 
further defines 

project

Team member 
conducts more 

research

Team member 
writes proposal

Yes
No Not enough info

Team reviews 
proposal

Proposal OK? Team member 
revises proposal

Team sends 
proposal to final 
decision maker

No

Yes

End of proposal 
process

Team Member 
Proposal Process
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Creating a Basic Flowchart 
• Open Visio  

• Under Category choose, Flowcharts 

• Visio will now open a blank drawing with the Flow-
chart Shapes relevant to the flowchart you have 
chosen. 

• Next, drag a flowchart shape onto the drawing.  

• Repeat this action as many times as necessary to 
complete your flowchart. 

• To connect the shapes you have placed on your 
document, use the connection tools. 

•  When connecting one shape to another, click the 
connection tool of your choice, and then drag 
from the connection point on the first shape to 
the connection point on the second shape. 

• To add text to your Basic Flowchart, select a 
shape, start typing your text, when finished typing 
click out side of the shape. 

 
 
 
 
 
 
 
 
 
 

Ordering Process
Monday, June 01, 2009

This flowchart explains the 
ordering process
At Contoso, Ltd.

Order Recieved

What type of 
customer?

Special Delivery? More than 1000 
items?

Notify shipping 
department 

details

Enter order 
information 

system

Notify warehouse 
with quantity 

desired

This step 
ensures that a 
delivery truck is 

available
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End

Receive 
Invoice 

via email

Invoice Paid?

Enter Invoice on 
calendar with 30-

day reminder

Start

No

Receive reminder 
from calendar

Time Delay

Invoice Paid?

Mail 
statenent to 
customer 

with amount 
due

Mail 
receipt to 
customer 

Set calendar 
reminder for 15 

days

No Yes

Accounts Receivable
Monday, June 01, 2009

End

Receive 
Invoice 

via email

Invoice Paid?

Enter Invoice on 
calendar with 30-

day reminder

Start

No

Receive reminder 
from calendar

Time Delay

Invoice Paid?

Mail 
statenent to 
customer 

with amount 
due

Mail 
receipt to 
customer 

Set calendar 
reminder for 15 

days

No Yes

Accounts Receivable
Monday, June 01, 2009

Flow Chart Examples 

Leaving the office

Check traffic and 
weather

Weather Clear?

Yes

Before 5:00 
p.m.?

Yes

Check for congestion 
on Primary Route

Yes

Primary 
Congested?

Divert to Alternate “B”

Yes

Take Alternate “A” 
Home

Take the Primary 
Route Home

Arrive Home Safely

No

No

No

No

Going Home Leaving the office

Check traffic and 
weather

Weather Clear?

Yes

Before 5:00 
p.m.?

Yes

Check for congestion 
on Primary Route

Yes

Primary 
Congested?

Divert to Alternate “B”

Yes

Take Alternate “A” 
Home

Take the Primary 
Route Home

Arrive Home Safely

No

No

No

No

Going Home
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Assemble

Check Clip 
Clearance

Form Spring

Assemble

Hold for 
Shell Tops

Assemble

Finished 
Goods

Clip Shell 
Top

Shell 
Bottom

Spring 
Wire Refill

Ace Pen Manufacturers
Manufacturing Process

Assemble

Check Clip 
Clearance

Form Spring

Assemble

Hold for 
Shell Tops

Assemble

Finished 
Goods

Clip Shell 
Top

Shell 
Bottom

Spring 
Wire Refill

Ace Pen Manufacturers
Manufacturing Process

Process: Hospital Key Patient Processes

Management Physicians & Nurses AccountingAdmitting

Schedule Patients

Register 
Patients

Receive 
Patients

Manage Patient 
Medical Info

Assure Quality Care for Patients

Release Patients

Generate 
Billing 

Records

Collect Payment

Glendale Central Hospital
Patient Processing

Process: Hospital Key Patient Processes

Management Physicians & Nurses AccountingAdmitting

Schedule Patients

Register 
Patients

Receive 
Patients

Manage Patient 
Medical Info

Assure Quality Care for Patients

Release Patients

Generate 
Billing 

Records

Collect Payment

Glendale Central Hospital
Patient Processing

Standard Workflow Diagram Cross Functional Workflow Diagram 
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YES

NO

Sales Dept 
takes order

Warehouse 
checks “Is product 

available?”

Manufacturing 
makes product

Packing 
department 

packs product Accounting 
Creates Invoice

Shipping Dept. 
Ships product

Accts Receivable 
receives payment

San Diego Widgets
Order Fulfillment Process

YES

NO

Sales Dept 
takes order

Warehouse 
checks “Is product 

available?”

Manufacturing 
makes product

Packing 
department 

packs product Accounting 
Creates Invoice

Shipping Dept. 
Ships product

Accts Receivable 
receives payment

San Diego Widgets
Order Fulfillment Process

Workflow Diagrams Using “Department” Stencil 
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text text

text

text

Block Diagram
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 Numbering Shapes 
To create a numerical order to your Flowchart shapes: 

• Select the shapes you wish to number. 

• Go to Tools, Add-ons, Run Add-ons 

• The add-ons dialog box will open, select Number Shapes … 
then click ok. 

• The Number Shapes Dialog Box will appear. In this box, under 
“Operation”, click “Auto Number”. 

• Insure the “Selected Shapes” serial button is selected under 
“Apply To” menu, then Click OK. 

 

 

Adding Pages 
When a Flowchart becomes too large you may need to create an-
other drawing to continue the thought pattern. 

To do this you: 

• Locate the Off-Page Reference shape    

• Drag it to the first page of your flowchart near the last shape 
you placed on you page. 

• This shape acts like a hyper-link between page one of your 
flowchart and page two. 

• Visio will open the Off-Page Reference Dialog box. 

• Click ok, and the Off-Page Reference shape will appear on 
your drawing and will create the new page it is connected to. 

• To move between pages using the Off-Page Reference shape, 
double click on the shape. 

1
Leaving the Office

2
Check Traffic and 

Weather

3
Weather 
Clear?

5
Before 5:00?

6
Check for 

Congestion on 
Primary Route

7
Primary 

Congested?

9
Divert to 

Alternate “B”

Yes

8
Take Alternate “A” 

Home

10
Take the Primary 

Route Home

11
Arrive Home Safely

No

No

No

4
No

The Best Way Home

Off Page 
Ref

Page 2 
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 Organizational Charts 
An organization chart is a diagram that shows the structure of an organization and the relationships and relative ranks of 
its parts and positions/jobs  

 

Creating a Single page Organizational Chart: 

1. Open Visio  

2.  Under Category choose, Organizational 
Chart 

3. Visio will open a blank drawing with the Org 
Chart Shapes menu open on the left side of 
the screen and the Org. Chart Toolbar 
floating on your screen. 

4. Depending on your type of organization, 
drag the most appropriate organizational 
shape onto the drawing. (there are seven 
different organizational chart shapes (see 
following page for blow-up): Executive, 
Manager, Position, Staff Position, Consult-
ant, Assistant and Vacancy, and each has a 
slightly different appearance) 

5. To show an association between two shapes 
you can first drag the second shape on top 
of the first, Visio will create the connection 
or you can connect them through the use of 
the dynamic connector or dotted-line report symbol. 

6. At this point the shape of your organizational chart is up to you. If you wish to add design elements to your org 
chart, you can click on Borders and Titles tab or the Backgrounds tab. 
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Note: The Organizational Chart Floating menu contains 6 unique (to Organizational Chart) buttons to        
assist the user in the creation of their organizational chart diagram. 

♦ Re-layout Button 
♦ Horizontal Layout Button 
♦ Vertical Layout Button 
♦ Side by Side Button 
♦ Move Left Button 
♦ Move Right Button 

 
  

Shapes available in the  
Organizational Chart  Stencil 
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Note: The Organizational Chart Floating menu contains 6 unique (to Organizational Chart) buttons to  
      assist the user in the creation of their organizational chart diagram. 

♦ Re-layout Button 
♦ Horizontal Layout Button 
♦ Vertical Layout Button 
♦ Side by Side Button 
♦ Move Left Button 
♦ Move Right Button 
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The Org Chart Menu 
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Enhancing the Appearance of Visio Drawings 
 

Color Themes 

• How can you transform a stark depiction 
of the facts into an attractive piece that 
will get the reader's attention?   

• Use themes in Microsoft Office Visio Pro-
fessional 2007 to add color and style to 
your diagram with just a few clicks.  

• Choose from a gallery of predefined 
themes, or customize themes with your 
own background colors, fonts, effects, 
and more.  

• Your diagram will jump off the page, plus 
you can make it visually consistent with 
documents you create in other Microsoft 
Office programs.  

Applying a theme 

• On the Format menu, click Theme. The Theme - Colors task pane opens by default. To open the Theme - Ef-
fects task pane, click Theme Effects. 

•  Tip   You can also click the Theme tool on the Formatting toolbar. 

• Do one of the following:  

• To apply a theme to the current drawing page, right-click a thumbnail, and then click Apply to Current Page. 

• To apply a theme to all the pages in your drawing, right-click a thumbnail, and then click Apply to All Pages. 

•  Tip   You can also click a thumbnail. Clicking a thumbnail applies the theme either to the current page or to all 
pages in your drawing, depending on what you did last. 
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Notes  

• To remove the current theme colors or theme effects from all shapes, in the Theme task pane, click the 
None thumbnail. 

• Some themes apply a background color to your drawing. If you don’t want the background color to appear 
when you print, select the No Background check box in the Print dialog box. 

• To enlarge the thumbnails, right-click a 
thumbnail, and click Show Large Pre-
views. 

• After you apply a theme, that theme is 
applied to any shapes you add to the 
drawing.  

• To temporarily disable this functional-
ity, clear the Apply theme to new 
shapes check box at the bottom of the 
Themes task pane. 
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 Add a Background or Watermark 

Add a background or watermark when you want the same graphical elements to appear on more than one drawing 
page. 

 Tip:  To selectively view, edit, print, or lock shapes on a single drawing page, use layers instead of back
 grounds. 

 

Add a background or watermark by using a background 
shape  

• Open the Backgrounds stencil if it is not already open. (On the 
File menu, point to Shapes, point to Visio Extras, and then 
click Backgrounds.) 

• Drag a background shape onto your page. 

 Note   To remove the background shape, drag the Background 
none shape onto your page. 

 
Create a custom background or watermark 
• Create a background page and assign it to one or more fore-

ground pages. 

For example, to turn your company logo into a background, 
create a background page with your company logo on it. As 
shown in the following illustration, the logo will appear on 
each page to which that background page is assigned. 

• Right-click a page tab in the lower-left part of the 

window, and then click Insert Page. 

• Click the Page Properties tab, and then click Background. 

• Add the shapes and text that you want to appear in the background.  
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Edit a custom background or watermark 
• You edit the shapes on a background page the same way that you edit the shapes on a foreground page. 

• Click the background page tab to display that background in the drawing window. 

• Edit the shapes and text in the background. 

Tip:   To see how the changes affect the whole drawing, display the background page in one window and 
the page that it is assigned to in another window. 

Assign a custom background or watermark to a foreground page 

• On the page to which you want to assign the background, on the File menu, click Page Setup, and then 
click the Page Properties tab. 

• In the Background list, click the name of the background that you want to assign. 

• The background appears behind the shapes on the foreground page. 

Notes  

• You can assign only one background to a foreground page. 

• When you assign a background to a foreground page, the shapes on the background are visible when you 
display the foreground page, but you cannot edit the shapes from the foreground page. 

 
 
 
 
 
 
 
 



Microsoft Visio Workbook      Page  37 

 

Borders and Titles  
• Open the Borders and Titles stencil if it is not already open. (On 

the File menu, point to Shapes, point to Visio Extras, and then 
click Borders and Titles.) 

• Drag a border or title shape onto your page. 

• To edit the title, click the title and type. 
 

Shape Sources 

• There are numerous sources for additional Visio shapes on the 
Internet; Here is one of them 

 
http://www.shapesource.com/scripts/prodList.asp?idCategory=21 
 

 
 
 
 



Microsoft Visio Workbook      Page  38 

 
 
 
 
 For more information about Visio,For more information about Visio,  

consider the following books:consider the following books:  

Books About Visio: http://www.amazon.com/s/ref=nb_ss_gw?url=search-alias%3Dstripbooks&field-keywords=Visio+2007&x=0&y=0 

 

For help, advice, or an appointment for tutoring ,  

please contact : 

 

David Newbold 

Information Commons 

Biomedical Library 

Telephone: 858-534-3746 

Email: dmnewbold@ucsd.edu 
 


